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Introduction

This quickstart manual will guide you through the features of Geneious 5.0’s interface and help
you orient yourself. You should also try the Geneious built in interactive tutorial which can be
found by selecting “Help” → “Tutorial” from the menu. For more information you can go
to http://www.geneious.com/education where you will find a number of tutorials on
more specific topics.

User Interface Overview

Figure 1: The main window in Geneious

On the left of Figure 1 are the sources and services in the “Sources Panel”. Here you can access
many online databases including NCBI and UniProt, then simply drag and drop sequences and
other data to your Local folders where you can store, view and analyse them in a customisable
workspace.

Right clicking (CTRL+click on Mac OS X) on the Local folders allows you to create new folders,
share them with other users, delete, rename or move them. You can also mark the contents as
read and export an entire folder including subfolders in a single operation.

http://www.geneious.com/education
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Selecting a data source displays the contents of that source in the “Document Table”. This
table always has columns relevant to the type of data you are working with making it easy to
sort and locate the items you are looking for. Click on the header of a column to sort or click
and drag the headers to reorder them. Right click (CTRL+click on Mac OS X) on the header to
change the columns that are visible. You can sort sequences by length or organism for example.

Use the filter box above the table to quickly locate items by keyword or click the search button
to access powerful searching functionality.

Selecting an item in the table gives you a view of the data in the “Document View” area below.
Geneious always chooses views which are appropriate for the data you have selected. Often
there are several of these so you can switch between them using the tabs directly above. A
pairwise alignment has an alignment view and a dotplot for example.

The “Help Panel” shows context specific information about the particular viewer that is in use.
It also includes the built in tutorial which covers the major functions of Geneious Pro.

If you need some extra space to work in, just click the “Expand” button to expand the view
or the “Open” button to open it in a separate window. You can also open a document in a
new window by double-clicking on it in the document table. Finally, you can open additional
views on a single document by clicking the “Split View” button. Selection is syncronised
between split view windows.

To access any of the analysis features in Geneious such as BLAST searching, sequence align-
ment and cloning just select the data you want to analyse before choosing the appropriate
analysis from the toolbar or menu.

Sequence Viewer Basics

The sequence viewer allows you to display your annotated sequence or alignment. The plus
and minus buttons increase and decrease the magnification of the sequence. You can zoom in
fully to view the bases/residues, and out to see an overview of the sequence(s). You can
also zoom to a selected region.

Zooming can also be quickly achieved by holding down the zoom modifier key (the Alt key
on Windows, Linux and Mac OS X) and clicking. When the zoom key is pressed a magnifying
glass mouse cursor will be displayed.

The colors option controls the coloring of the sequence nucleotides or amino acids. Color-
ing schemes differ depending on the type of sequence. For example, the “Polarity” and “Hy-
drophobicity” coloring schemes are available only for Protein sequences.

Annotations can be shown and hidden by opening the “Annotation Types” section of the se-
quence viewer panel and clicking the checkbox next to each annotation type (Figure 2).
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By selecting a region and clicking “Add Annotation” , a custom annotation can be added to
a region of interest. Just enter a name and click OK. Annotations can also be copied between
sequences by right-clicking (CTRL+click on Mac OS X) on the annotation.

Figure 2: A view of an annotated nucleotide sequence in Geneious

Databases

Geneious allows you to search for documents within your local folders with ease. Clicking the
“Search” button at the top right of the main window when a folder is selected will allow you
to find documents by text or sequence (Figure 3). Select the top “Local” folder and click Search
to search all of your local folders.

Figure 3: Searching the local folders

Geneious Pro integrates closely with many online databases including a large number from
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NCBI such as Nucleotide, Gene, SNP, PubMed and Taxonomy as well as UniProt and PFam.

To search any of these text-based databases, select the database in the sources panel then you
can perform a simple keyword search by entering your keyword(s) in to the search box and
clicking the “Search” button. To search using a more complex combination of terms, click the
“More Options” button to the right. (Figure 4).

Figure 4: Searching the PubMed database

The results of your search are displayed as they are downloaded from the internet.

While this is happening you can sort by any of the columns or filter to find keywords like a
particular country or species.

Selecting data, immediately gives you a graphical representation of results without having to
navigate away from the search.

When you’ve found what you’re looking for save it by clicking and dragging the document(s)
from the document table over to the desired folder in the sources panel.

Sequence Search

Geneious Pro also features integrated access to NCBI’s BLAST databases and the ability to set
up your own local personal databases using Custom BLAST.
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To search for similar sequences in any of these databases, first select your query sequence (or
several for a batch search) then click on the “Sequence Search” button. The options that are
displayed allow you to choose the database and parameters for your search.

Once you click the search button, Geneious creates a folder for the results and starts download-
ing them when the search is complete (Figure 5). Your results are saved straight away so you
won’t lose them even if you have to close the program.

Figure 5: Sequence Search Complete

Import, Export and Storage

Geneious Pro supports importing and exporting a wide array of formats including PDF, FASTA,
GenBank and Vector NTI allowing you to share data between many different programs. Geneious
will usually be able to recognise the format of a file automatically so you can just click and drag
files directly into the Geneious window and they will be imported. Geneious also has a special
Vector NTI database import option to import all your data from Vector NTI in one operation
(“File”→ “Import”→ “Vector NTI Database”).

In addition to exporting in bioinformatics formats, Geneious also supports high quality graph-
ical export for printing and inclusion in publication. More details can be found in the section
on printing and exporting images later in this document.

As well as storing data on your hard drive, Geneious Pro can also utilise a private SQL server.
This allows multiple users to access data simultaneously; great for managing group projects,
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and gives added security through access controls and backups. For more details on setting this
up refer to the Geneious Manual.

Agents

To help you stay up to date with the ever-changing contents of all these databases, Geneious
Pro brings you Agents.

Agents make sure you always have the latest data by performing searches automatically and
telling you when new data becomes available.

They can be used to run a BLAST search every day and tell you when new sequences that are
similar to your query have become available.

Alternatively, you could use an agent to stay up to date with publications from your favourite
researcher or on your favourite topic (Figure 6).

To create an agent or check on your existing agents, click the “Agents” button in the toolbar.

Figure 6: Create a PubMed Search Agent

When an agent finds a new publication or sequence, it’s just like receiving a new email.
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Collaboration

With collaboration you can connect to our public server, or a secure local server, then share
your documents with other Geneious users from within the program streamlining collaborative
research.

You can see when your colleagues are online and share documents. For full details on setting
up collaboration refer to the Geneious Manual.

Assemble

For sequence assembly, Geneious Pro supports import of traces from both ABI and SCF for-
mats.

Once you have acquired your fragments for assembly, you can perform assembly in the same
way that almost all analysis is performed in Geneious.

Select the documents for analysis then click on the “Assembly” button. You are then asked to
choose the parameters for your analysis. Assembly includes options for alignment stringency,
selecting a reference sequence and automatic trimming.

Click OK and once the assembly is complete, Geneious automatically selects the result so you
can view it.

Figure 7: Assembled contig

In this contig (Figure 7) trimmed annotations are ignored during the assembly and in calcu-
lation of the consensus. This means you can keep the trimmed regions for future reference
without them disrupting your assembly.
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Disagreements between reads are identifiable as black bars. You can also jump quickly to each
disagreement by pressing Ctrl+D ( +D on Mac) on the keyboard.

Zooming in on one of these (Figure 8) you can see the base calls with the trace above.

Figure 8: Editing an assembled contig

The quality of the bases is illustrated by the blue graph behind the trace.

You can zoom in further to help resolve tricky base calls. Control the height of the graph using
the options on the right.

To manually resolve conflicts, edit bases within the same view by clicking “Allow Editing” and
just typing in the new base. Edit the consensus sequence to quickly change all base calls at one
position.

When you are satisfied with your assembly, select the consensus sequence, click “Extract” and
choose a name to save it to a separate document for further analysis.

Restriction and Cloning

The circular sequence viewer (Figure 9) not only gives an overview of the features on a se-
quence, it also allows you to zoom in, view the bases and even edit them.

Restriction analysis is performed in real-time inside the Sequence View. Select the “Restriction
Analysis” tab on the right of the sequence viewer and Select “Find Restriction Sites”. Any
cut positions will be shown on the sequence.

You can create custom sets of restriction enzymes, perhaps the ones that are available in your
lab fridge, making it easy to identify cut sites for the enzymes that are available.
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Figure 9: Viewing a plasmid

Figure 10: Insert sequence into vector
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Click “Apply” to save the current cut sites for use in further analysis.

Geneious Pro simplifies virtual cloning with its one-step “Insert into Vector” function. After
identifying cut sites on your insert this function will take care of the rest by finding compat-
ible enzymes for the plasmid then performing digestion and ligation in one step (Figure 10).
Geneious also supports Gateway® Cloning.

Primers

Geneious Pro includes Primer3 for primer design and testing. Selecting a region or annotation
as a target for amplification, you can quickly design a primer to surround it (Figure 11) using
the “Primers” button. Primer design has many options so you can design the right primer
for your experiment. These include limits on melting point, GC content, primer size and many
more.

Figure 11: Design a pair of primers

When you click OK primers will be designed and added to the target as annotations. To view
the statistics for each primer, hold your mouse over the annotation in the sequence view. To
save a primer for ordering or testing against other sequences, just click on the annotation and
click “Extract”.
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Align Sequences

Figure 12: Dotplot viewer

Geneious Pro makes pairwise and multiple sequence comparison easy. Selecting two sequences
gives you a dotplot for initial comparison (Figure 12).

Further investigation can be done using the built in sequence alignment tool. With the se-
quences for alignment selected, click the “Alignment” button in the toolbar.

Geneious Pro includes built in implementations of global and local alignment as well as several
multiple aligners including ClustalW and MUSCLE (Figure 13).

You can change substitution matrices and gap penalties to optimise your alignments. Once an
alignment is complete, the alignment view is automatically displayed.

Alignment Viewing

Initially, Geneious gives you an overview of the alignment. It displays a graph of identity along
the top and you can see the annotations and gap locations on the sequences themselves.

Within the alignment view, you can zoom in to see the bases and customize the settings on the
right to create the view which is best for your analysis (Figure 14). You can also display protein
translations alongside the sequences, customise color schemes, graphs, consensus options and
annotations.
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Figure 13: Alignment options

The statistics section at the bottom is updated in real time as you select a region. On a protein
sequence, this includes molecular weight and isoelectric point.

To modify your alignment manually, click on “Allow Editing” then type in characters directly
with the keyboard or click and drag regions of the alignment to change gap locations.

Phylogenetics

Going from a multiple alignment to the next step - building a tree is simple. Just select the
alignment and click the “Tree” button.

Geneious Pro features basic tree building such as Neighbour-Joining and bootstrapping. Plug-
ins are also available for more advanced analysis including Mr Bayes and PAUP*.

Trees are displayed in an interactive viewer that allows editing and customisation of the view.
You can rearrange the tree and color the branches for example (Figure 15).

If you select a subtree by clicking on it, the corresponding sequences are also selected in the
associated multiple alignment (click on the Alignment View tab).

3D Structure Visualisation

Geneious Pro includes a powerful viewer for common 3D biological structure formats such as
PDB. Structures can be rotated by clicking on the structure and dragging the mouse. You can
zoom by holding the Shift key while clicking and dragging, and individual components down
to atoms can be selected and highlighted (Figure 16).
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Figure 14: Multiple sequence alignment

Features of molecules can be explored allowing you to see the fine detail of the structure of the
polypeptide chain as well as simplified views such as cartoons to show the overall structure and
views can be combined and include custom coloring using the menu at the top of the structure
viewer window. When you have finished you can save the structure and your display settings
will be preserved.

For advanced users, the command box lets you type in arbitrary jmol scripting commands. To
see some examples, select one of the pre-populated options in the boxs drop-down. For a com-
plete description of the commands you can use, see http://www.stolaf.edu/academics/
chemapps/jmol/docs.

Printing and Image Exporting

Any view within Geneious Pro can be printed or saved for publication. Saving features in
common formats like JPEG and high quality vector formats like PDF. Simply set up the display
the way you want and select “File”→ “Print” or “Save as Image File”. A dialogue will appear
allowing you to control the way the image is laid out on the page (Figure 17).

Teaching

Geneious Pro is great for teaching bioinformatics. It gives students easy access to all the tools
they need without requiring them to learn tricky command line interfaces. This means they

http://www.stolaf.edu/academics/ chemapps/jmol/docs
http://www.stolaf.edu/academics/ chemapps/jmol/docs
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Figure 15: Tree viewer showing colored branches

spend less time learning the tool and more time understanding the analysis.

Geneious Pro features interactive tutorials which guide students through analyses linking them
to relevant data and allowing them to answer questions for submission. These can be down-
loaded from http://www.geneious.com/education.

http://www.geneious.com/education
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Figure 16: Viewing a 3D structure

Figure 17: Printing an image


